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Thank you for your purchase of LINEEYE's protocol analyzer. To use it correctly, you are advised to read 
and understand this instruction manual thoroughly. Keep this together with the warranty. If you encounter any 
problems, you will find helpful information in this manual. 

NOTICE
■ It is prohibited to reprint or duplicate any part or the whole of this instruction manual without prior permis-

sion from LINEEYE.

■ The contents of this instruction manual and specifications of the products are subject to change without 
notice.

■ This instruction manual has been designed and edited with great care to give you all necessary information. If 
you have any questions, feel free to direct your inquiries to LINEEYE CO., LTD.

■ LINEEYE assumes no responsibility whatsoever for any damages resulting from the use of this product. 
Furthermore,LINEEYE makes no guarantee of data etc. When data disappears, or even when the recorded 
data has broken while using this product.

USER LIMITATION
This product has been developed for the purpose of using as an analyzer only, and has not been developed for 
the use that needs exclusively high reliability and safety; aerospace apparatus, trunk communication apparatus, 
nuclear control apparatus, medical apparatus related with life maintenance and etc. Also, this product does not 
warrant the use for those purposes. If you use for those purposes, please consider the safety measures against 
fail-safe etc. on your responsibility.
This product has Wi-Fi function (IEEE 802.11b/g/n) and emits radio wave when working. Please do 
not use near a medical device, microwave, high-level electronics, TV, radio, wireless station for mobile 
communications, or specified low power radio station. Where an administrator limits the use of radio devices, 
follow the instruction of the administrator.
However, without the Wi-Fi setting file in the inserted SD card the Wi-Fi function is invalid and it does not emit 
radio. 

SIMPLIFIED EU DECLARATION OF CONFORMITY
Hereby, LINEEYE declares that the communication protocol analyzer type LE-270GF / LE-270AF with radio 
remote-control function is in compliance with Directive 2014/53/EU.
The full text of the EU declaration of conformity is available at the following internet address:
https://www.lineeye.com/html/contactus.html 

Wi-Fi AVAILABLE COUNTRIES
The Wi-Fi function of the analyzer is available only in Japan, USA, Canada, and the EU nations where the 
product needs to be conformable to RE directive (2014/53/EU) for use.

INTRODUCTION 
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CAUTION

■ Do not disassemble or modify. 
   This may result in fire, an electric shock and/or unit malfunction.
■ Stop using the analyzer immediately when smells emanate from itself.
   Continuous use may result in an electric shock, a burn and/or fire.
■ Keep the products away from water.
   Failure to do so may result in the heat generation, an electric shock and/or unit malfunction.
■ Do not short-circuit the connector pins.
   This may result in the heat generation, an electric shock, unit malfunction and/or injury.
■ Do not use deteriorated cables (damage etc.).
   This may result in the heat generation and fire.
■ Do not use in the place which generates inflammable gas etc. 
   This may result fire.

■ Do not use and keep this product in the following places:
	 ●	 The places exposed to the direct rays of the sun.
	 ●	 The places with the humidity and temperature exceeding the tolerance level, and  
            with a rapid temperature change.
	 ●	 The places with much dust and moisture.
	 ●	 The places near the objects which generate heat (the heater etc.).
            Using in these places may result unit malfunction and /or injury.

This Safety Information includes the important information in order to not only have you learn the right way to 
use the analyzer, but also prevent you from causing damage to people and property. Before using, please read 
the main contents after you understand the following contents (symbols and marks).

	 [Explanation of the symbols (The degree of the hazard factor)]

	 WARNING 
The symbol denotes that improper handling poses a risk of causing death or serious injury. 

	 CAUTION 
The symbol denotes that improper handling poses a risk of causing injury*1 or damage to the product 
and property*2. 

*1: “Injury” indicates injury, burn, an electric shock, or the like which does not require hospitalization 
or the extend over a long period of hospital visit.

*2: “Damage to the product and property” indicates damage expansion related to a house, a building, 

Safety Information 

Read this first ! ! 

WARNING
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Software License Agreement
LINEEYE CO., LTD (LINEEYE) grants you to use the software program and accompanying documents under terms of this 
license. And you are consenting to be bound by and are becoming a party to this agreement. To use the software, you need to 
agree to this license agreement.

 
1.   Copyright

LINEEYE holds the copyright on this software.

2.   Grant of License
LINEEYE grants for you to use this software on only one computer by getting the software and agreeing this license 
agreement. Therefore, you shall not rent, lease and loan to a third party.

3.   Copy, Analysis, Modification
This software must not be reproduced, analyzed or modified in any form unless prescribed in the manual.

4.   Upgrade
This software may be upgraded without advance notice because of technical progress of hardware or software. 
LINEEYE provides software upgraded by payment specially. For upgrade, only licensed user can have upgrades. 

5.   Limitation of Liability
In no event shall LINEEYE or its licensors be liable for loss of business or profits, or for any direct, indirect, incidental 
or consequential damages arising from products of this software or the related software. Besides LINEEYE shall not be 
liable damages arising from the equipment or the medium.

6.   General 
If any provision of the agreement is held invalid, such provision shall be removed from this license agreement.

7.   Support
LINEEYE supports functions, operation and only the problem on this software.  

8.   Notice
Any matter not specified in this agreement will be governed by and constructed in accordance with copy right law and 
related laws. 
									        LINEEYE CO., LTD.
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Chapter 1 Before Using the Product
LE-270AF/LE-270GF is the CAN/LIN communication analyzer, which can be used as a PC-connectable 
protocol analyzer and PC-less Data logger.It has two High-speed CAN/CAN FD transceivers, and two LIN 
transceivers. It monitors two channels of CAN/CAN FD or LIN, or one CAN/CAN FD and one LIN channels. 
In addition, four channels of Analog/Digital signals can be recorded. LE-270GF has GPS receiver and accelera-
tion sensor and can register positioning and acceleration information besides CAN/LIN communication data. 
Power failure protection, water-proofing and low power consumption widens the usage of analyzer such as in 
the automation factories and other production factories,

1.1 Composition
When you unpack the product, please make sure of the following

Protocol Analyzer									         : 1
Utility CD (CD-ROM)								       : 1
SDHC card (8GB)									        : 1
Mini USB cable									         : 1
CAN/LIN Dsub cable (Model: LE-25M3A-1)		 : 1
Power plug cable (Model: SIH-2PG)				    : 1
Instruction Manual									        : 1 (This book)
Warranty											           : 1

* Please contact LINEEYE distributor or us if you find any insufficient part of any damage to the product 
   caused by transportation.

* Please keep the box carefully to use it when sending the product back to us for repair etc.

● Utility CD
Utility CD contains the analysis software, driver and some instruction manuals of analyzer and its options. 
You can download the update file of software from https://www.lineeye.com

1.2 Outline
	 ■ Functions

	 1).	 On-line Monitoring
	 Monitor the transmission/reception data on-line to check the existence of hindrance and communication   
　  data in the line or to analyze the communication.

	 2).	 Simulation function
	 The product takes a role of a node of CAN/LIN and transmits the data frame or remote frame set by the 
　   user. 

	 ■ Feature
		  * 2-way operation of PC-connected protocol analyzer and data logger that can be installed on site without a 	
		     PC.
		  * Multiple analyzers can be controlled remotely by one PC for monitoring.
		  * Measure two channels of CAN/CAN FD/LIN in combination and four channels of Analog/Digital signals  	
		     at the same time.
		  * Powerful trigger function and ID filter for sufficient analysis.
		  * Record measured data continuously in the HDD of PC or SD card. 

　　　   (SD card capacity is up to 32GB).
		  * Specify the recording time by Real Time Clock. Turn On/Off the power automatically.
		  * Power failure protection and wide range of ambient temperature make it possible to use it in the severe 
		     conditions. (-20℃ - +55℃ ) 
		  * Compact size. Able to use the 35mm DIN rail.
		  *You can receive the file of the measuring data in logger mode through Wi-Fi.

 8.3 Receive the logger files by Wi-Fi connection. 
		     (The Wi-Fi function is available only in Japan, USA, Canada, and EU nations where the product is 

needed to be compliant with RE directive (2014/53/EU). ) 
		  *You can log the GPS positioning and acceleration data.  [Supported only by LE-270GF]
		  *The measurement port is isolated from the USB port by the galvanic isolation  [Only LE-270GF]
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1.3 Explanation of Each Part

1)	 Measurement Interface
The measurement interface consists of a DSUB 25pin connector to connect to CAN/LIN target devices 
and external input signals.
Measurement port is isolated from USB port by galvanic isolation(1kV) (Only LE-270GF).

2)	 LED
	 POWER/ERROR   : Indicate the operating status of analyzer.
	 RUN/ACT              : Indicate that analyzer is measuring or accessing to the SD card.

1)
3)

4)

2)

5)

6)
7)

*1: Do not remove the SD card while lighting.
*2: By starting measurement in Protocol Analyzer Mode, you can set the PC time to the internal 

clock.
*3: Contact LINEEYE distributors or LINEEYE for support.
CH1/CH2 : Indicate the logic status of CH1/CH2 Line. Display the logic state of CH1 line(green - 

blink ) and CH2 line(red - blink). 
 U1/U2 : Able to light the U1 (green) /U2 (red) by trigger actions.

POWER/ERROR RUN/ACT Status
Light off Light off Power Off

Green light

Light off

Protocol Analyzer Mode

Ready to operate
Green light Under measurement
Red light Accessing to the SD card *1

Orange light Measuring and Accessing to the SD card *1

Orange light

Light off

Logger Mode

Ready to operate
Green light Measuring

Green blinking Ready to start measuring 
Red light Accessing to the SD card *1

Orange light Measuring and Accessing to the SD card *1

Orange blinking - The built-in clock has been initialized and 
needs to be reset.*2 

Light off Green light Firmware Update Mode
Red blinking
(high speed) - Error Self check error, exception error  *3

8)

3)

4)

2)

5)

6) 7)

1)

LE-270AF

LE-270GF
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<Dust-proofing cover>

There is a dust-proofing cover on the SD card slot and USB connector. To remove 

the SD card, open the cover as following. 

Also, it is possible to open the cover for USB connector only as following. 

WiFi/GPS : When you select “Station” in the Wi-Fi setting of “Wireless LAN configuration file”, 
the LED lights in green (WiFi) when it completes connecting with an external Wi-Fi 
access point. 
When you select “Access point” in the Wi-Fi setting, it lights in green (Wi-Fi) when the 
access point in the analyzer runs.
For LE-270GF only, the LED lights in red (GPS) when the analyzer receives a GPS 
radio. 

* The LED is two colors LED and it looks orange when both of them light. 

	       3)	 RUN/STOP Switch
			   Press to start measuring. Press for a while to stop measuring.

		  4)	 SD Card Slot
Insert the SD card as the following figure. To remove the SD card, press the SD card and it will come 
out from the analyzer. 

		  5)	 USB Connector
			   Use the included USB cable to connect the host PC. 

		  6)	 DC Jack 
Connect the power supply when using the analyzer as a Data Logger. Optional plug cable “SIH-2PG” 
is available.
DC plug type: center-plus, outside diameter 5.5mm, inside diameter 2.1mm.

		  7)	 M3 Screw Hole
			   This is for connecting the analyzer on the DIN rail. Pitch: 70mm. Depth: 3.5mm (max).

		  8)	 Connector for GPS antenna (Only for LE-270GF)
                  SMA connector (female) for active GPS antenna
                  Connect a GPS antenna.
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2.1 System Requirement
HDD			   : 35MB + capacity for recording communication log 
OS			   : Windows 10/11
Port			   : USB 2.0 port 
SD card drive	: It is required for the Data Logger mode to save log files and to read configuration settings.

* When you use Wifi function, Wi-Fi access point which supports IEEE 802.11 b/g/n (2.4GHz) is needed.
The Wi-Fi function is available only in Japan, USA, Canada, and EU nations where the product is needed    
to be compliant with RE directive (2014/53/EU).

Chapter 2 Installation

Install the analysis software"LE-LIK27F" to the PC you are going to operate the analyzer. 

■ Uninstall
1.	 Open “Add/Remove Application” in the “Control Panel.”
 	 (It might be “Add/Remove Programs” for other OS.)
2.	 Select “LE-LINK27F” and execute “Remove”.

2.2 Installation of the Analysis Software 
■ Install

1.	 Insert the included CD-ROM into the CD-ROM drive of the PC.
	 Open the folder of “pcsoft” and click on “Setup.exe”.
2.	 Click “Yes” if the user account dialog box appears. 
3.	 Follow the Install Shield wizard.
4.	 Read the software license agreement and click “Yes”. 
5.	 Input the serial number of analyzer. (Check the back side of the analyzer)
6.	 After setup has completed, click “Finish”.

7.	 Protocol analysis software (LE-LINK27F) is installed. 

2.3 Set up for the internal RTC (Clock IC)
The lithium secondary battery supplies back up power for the internal RTC (Clock IC). When you use the 
analyzer for the first time or when you have not used it for a long time, before using it in logger mode, connect 
the analyzer with a PC by USB cable and execute the measurement operation for once in protocol analyzer 
mode. When it starts the measurement the time and date in the PC will be set to the RTC in the analyzer. While 
this operation (for the minutes) lithium secondary battery will be charged and the RTC keeps the date and time 
for about two days in the power-off condition. When the analyzer is powered for hours, the battery will be fully 
charged and the date and time in the RTC will be kept for more than 6 months.
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<SHI-2PG>
Connect the black/white cable to the positive electronic pole of DC power.

Chapter 3 Basic Operation

3.1 Connection

■	 Protocol Analyzer Mode

■	 Data Logger Mode

● For CAN communication, connect following signals.
Signal Meaning Measurement port Dsub25 connector

CAN_H CAN bus signal Connect to CAN1H (15) or CAN2H (19)
CAN_L Connect to CAN1L (16) or CAN2L (21)
GND Signal ground Connected to either (4), (7) or (22) of GND

* Low Speed CAN is not supported.

● For LIN communication, connect following signals.
Signal Meaning Measurement port Dsub25 connector

BATT Battery power supply (9-18V) Connect to BATT (1)
LIN LIN bus signal Connect to LIN1 (23) or LIN2 (24)
GND Signal ground Connected to either (4), (7) or (22) of GND

* BATT cannot be supplied from this machine, so please supply it externally.
* Connect after supplying power to this unit. If you connect first, it will start up in data logger mode.

 10.1 Interface (CAN/LIN/External Input)

<External power supply>
・ External power supply range for DC IN is from DC9V to 34V. 
   (The peak surge voltage should not exceed 34V at power-on.)
・ External power supply range for BATT of the Dsub25 is from DC9V to 34V. 
   (The peak surge voltage should not exceed 34V at power-on.) 
・ Power consumption of LE-270AF is 120mA when DC is 12V. (230mA when using Wi-Fi)
・ Power consumption of LE-270GF is 170mA when DC is 12V. (280mA when using Wi-Fi) 
・ Suitable DC plug is center plus 5.5mm (outside) / 2.1mm (inside).

		  

	 1). Connect the USB cable to the analyzer
	 2).	 Connect LE-270AF/LE-270GF by 		

	USB or Wi-Fi with the PC to which 		
	 the analysis software is installed.

	 3). Connect the analyzer and target 			 
	 devices using the LE-25M3A-1.

	 1). Connect the DC plug cable (SIH-			 
	 2PG) or AC adapter (6A-181WP09) to 	
	 the analyzer.

	 2). Insert the SD card, which saved the 		
	 configuration settings of the analyzer.

	 3). Connect the analyzer and target devices 	
	 using the LE-25M3A-1.
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3.2 Configuration of Analysis Software
■	 Execute the analysis software

Start “LINEEYE” and “LE-LINK27F” from the Windows “Start” menu. 
From [Start] menu of Windows, go to [LINEEYE] -> [LE-LINK27F]. 
The following data window will appear for the first time. 

1).	 Menu
	 Perform various operations.
2).	 Tool Bar
	 Perform various operations. 
	 Multiple connections of analyzers can be made 

using the [       ] button (or the menu item 
[Tools]->[Connection Setting List]).

 3.3 Multiple analyzer connections

3).	 Data Display
	 Display the measured data.
4).	 Data Position Display

■	 Connection Settings

	 Click “ ” on the tool bar of the data window (or “Measurement” -> “Connection setting”) and set the 

	 connection settings and data saving settings. 
	 The connection settings consist of “Connection” and “Measurement data”.

 ●	“Connection” tab
“Connection method” are for the setting of connection.

1)  
2)

3) 

4)								        5)	

<Wi-Fi>

<USB>
“Serial number” (USB)
	 Set the serial number of the analyzer to be controlled.
	 You can select it from the drop down list when the 					   
	 analyzer is connected.		

“Host name”
	 Set the IP address of the analyzer.
“Data Port”

Set the port number for the send/receive of the measured 
data. Set the same port number set to the analyzer.

	 Display the data file name and data position of Data display. The number of data loss will be displayed 
while monitoring.

5).	 Model Name Display
	 Display the model name of analyzer.

		  



-10-

●	 Measurement Tab
	 Setting for the saving destination of the measured data, file size, and behavior in the protocol analyzer 

mode.

[A folder to save the monitor data] 
	 This folder is for saving the measured data. 
       To change the settings, click “Change” button. 
	 Then the window to select a folder will be 
	 appeared. Select the proper folder and click 
	 “OK”. The file name of saving data is started 
	 from “00000000.DT” in numerical order.

* Recommend specifying an exclusive folder.
* Specify a drive, which has enough capacity. 
(When it does not have enough capacity, the PC 
may not operate correctly.) 

Attention: If there is not any folder in the place you specified, a message dialog will be appeared.

[Block Size] 
Set the data capacity per a file. You can select from 128K/1M/2M/4M/8M/16M/32M byte.

[Maximum Block Count]
Set the maximum file number to save. You can set from 2 to 1000. When the number of the data file 
exceeds this number, the data file with the lower number will be deleted. 

[Full Stop]
If the stored files reach to the maximum block number, it will stop measurement automatically. If you 　  
do not select it, the analyzer records data continuously as a ring buffer. 

[Append Mode] 
When measurement starts, a newly-created file is saved in the order after the existing files. If the	
number of the whole data files exceed the maximum block number, a data file with the lower number 
(includes data files which were saved on the former measurement) will be deleted even in the append 
mode. If  you do not select it, the former data will be deleted and start the file name from “00000000.
DT”.

[Warning Display]
It warns that there is the former data in the file you specified as a saving file. 
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■	 Analyzer Settings 

	 Click “ ” on the tool bar of the data window (or click “Measurement” -> “Measurement setting”) to set the 

	 target bus, speed and so on. On the measurement setting window, every time you change the setting on the left 

	 side of the window, the contents of the setting (on the right side of the window) will be changed. Click “ ” 

　  to save the configuration as a “.SU” file.  Click “ ” to read the configuration file. 

●	 Interface
                                                                                           Ch-1 interface/Ch-2 interface
                                                                                             Select the interfaces of CH1 and CH2 from CAN  　                                                                                                                                                

                                                                                       or LIN.When measuring CAN-FD, select CAN.
                                                                                           Ch-1 CAN terminator	
                                                                                             You can connect the terminal end (120Ω) to the       　                                                                                                                                                

                                                                                       CAN port side of the Ch-1 in the analyzer.

●	 Record Control
Set the Time stamp resolution selection, ON/OFF of 
GPS/Acceleration Measurement(*1), 
Interpolation of GPS record(*1), Capture control at the 
start of measurement, Interpolation of External input(*2), 
and External input range.
*1:  LE-270AF cannot measure GPS/Acceleration 

function.
*2:  When “Interpolation of GPS record” is selected, 

GPS positioning data measured approximately 
every second is copied and recorded to all commu-
nication frames captured faster than that period. 
GPS and acceleration measurement functions are 
only available on LE-270GF. . 

 4.5 Analog measurement settings

Select the mode of the analyzer. 

[ONLINE] (Online mode) 
This mode monitors CAN/CAN FD and LIN data 
along with the analog value and logical status 
(EXIN1 to EXIN4). The relationship between 
external signals and communication data are clearly 
visualized. 

 4.5 Analog measurement settings

●	 Function

“MANUAL” (Simulation mode)
It outputs the data which already set to the simulation data table from CH1(CAN1/LIN1).
“Schedule” Schedule setting for the analyzer when it is LIN master.

		  

		  
●	 Data Monitor

[Configuration]	 Set the speed of target devices. 
 4.1 Communication Condition

[Trigger]	 Set the trigger conditions and actions. 
 7.1 Trigger Function
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●	 Simulation data table
      [Table 0 to F]   Set the frame to be sent.
					     For LIN, set the response field data, and for master simulation, set the header field ID in the 	

				    request ID table on the function selection screen. 
 5.1 Preparation of Simulation

●	 Logger Setting

	 [Data Save]
	 	 Set the file size and number of files to save for a Data Logger Mode. 

 Chapter 8 Data Logger Mode

	 [Auto RUN/STOP]
		  Set the starting time and ending time of the auto-measurement. 

 8.4 Auto Run/Stop Function

		  

		  

		  

3.3 Multiple analyzer connections
To connect and use multiple analyzers at the same time, register the number of analyzers in the Connection 
Setting List window. 

To register, click the [         ] button on the toolbar of 
the Connection Settings List window (or click [Con-
nection Settings] -> [Settings] in the menu). 
The Connection Setting window similar to the Data 
window will open and the settings are configured. 

 3.2 Configuration of Analysis Software

Select the connection settings and click on the [        ] 
button on the toolbar (or [File]->[Open data window] 

		  

in the menu). 
The data window will open.  

To delete a connection setting, select it and click the [        ] button (or the menu item [Setting] -> [Delete Set-
ting]). 

The connection setting list (this window) 
will be opened.

: The connection settings list window will be opened at the next 
startup. 

The data window will be opend.
(Order in the setting list)

: The data window will be opened at the next startup in the order of 
the list of connection setting. 
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Chapter 4 Monitor Function 

The monitor function records communication data in the files automatically without affecting the 
communication lines. The results are displayed as CAN, CAN FD and LIN frames. Not only communication 
data but also the time stamp and external signals are recorded, thus the error time and conditions of external 
equipment are clear to see. Also, the trigger function, which detects specific communication, can be set. 
Moreover, LE-270GF can obtain positioning by GPS receiver and acceleration information by acceleration 
sensor. 

4.1 Communication Condition

Click “ ” on the tool bar of the data window (or click “Measurement” -> “Measurement setting”). Set the 

communication condition for target devices. 
<CAN setting>

	 ●	Baud rate / Baud rate (Data)
Select the speed (125K to 1000K) for CAN and CAN FD, or input the speed directly.
* Applicable rate by the circuit is automatically set. If the tolerance rate appeared on the right side is big, it 

is possible that the analyzer cannot measure well.
* Select the ”Baud rage (data)” for CAN FD data phase (1000K to 5000K), or input the speed directly.

●	Sample point / Sample point (Data)	
Select the bit sample point within 60% to 90% , or input directly.
* If inputting the number directly, the actual setting number will be displayed on the right side.
* Sample point (data) is for CAN FD data phase.

	 ●	CAN FD CRC type
Select the CRC type for CAN FD from “ISO CRC” or “non-ISO CRC”.
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●	ID filter 
Sets whether capture filtering by ID is used or not.
Multiple selections can be made from "Acceptance," "Pass," and "Cut.. 

●	Acceptance
It captures a corresponding ID frame by the hardware filter. 
Hardware filter, captures frames with matching ID.
In the Acceptance Settings tab, set the standard field ID (bits 10-0/29-18) and the extended field ID (bits 
17-0) bitwise ("0", "1", "*" (don't care)).

(Example) Capturing a frame whose extended format ID is 00000023h  (HEX).

Standard ID Field : 000000000
Exlended ID Field : 000000000000100011 

(Example) Capturing a frame whose extended format ID is 00000023h  (HEX).

Standard ID Field : 00000100011
Exlended ID Field : ******************

Note: In an environment with mixed extended formats, 008C0000h to 008FFFFFh are also captured.

・ PASS
It captures a corresponding ID frame by the software filter. 
At the pass setting tab, select the standard format or the extended format and then set the ID by HEX ("0" 
to "F", "*" (Don’t Care)). (You can set up to 8) 
When standard format, set the values from ID:0 to 7FFh. When extended format, set the values from 
ID:0 to 1FFFFFFFh. 

Note:  If all checkboxes are unchecked (disabled) when the pass filter is enabled, all ID frames will not 	
				   be captured.

     (Example) When capturing frames with standard format IDs from 010h to 01Fh.

・ Cut
It does NOT capture the frames which have corresponding ID by a software filter.
Select standard format of extended format at the cut configuration tab and set the ID by HEX 
(“0” - “F”, “*”, (Don’t care)). (You can set up to 8 items)
Configure values within the scope of ID:0 – 7FFh when it is standard format, 
and configure values within the scope of ID:0 – 1FFFFFFFh when it is extended format.

Note: If all checkboxes are unchecked (disabled) when the cut filter is enabled, all ID frames will be 	
			     captured.

    (Example) If you do not capture frames with standard format IDs from 020h to 02Fh
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<LIN setting>
	

●	Baud Rate
Select from 2400bps, 9600bps or 19200bps. 
Also, it is possible to set an arbitrary speed. (Any four digits between 400bps to 26000bps.) 

●	ID Filter
Set the ID filter settings. Set the 5 to 0 bits of ID as "0", "1", or "*" (Don't Care).
Only frames with matching IDs are captured.
If all bits are set to "*" (don't care), no filtering will be performed.

(Example) Display frames of ID 00
- - 0 0 0 0 0 0

(Example) Display frames of ID 01
- - 0 0 0 0 0 1

(Example) Display frames of ID 00 or 01
- - 0 0 0 0 0 *

●	Frame End
Select whether frames are terminated in "time" (the maximum value in the standard) or "DLC" (data length 
per ID).
Normally, "DLC" is selected. If "DLC" is selected, the DLC and checksum calculation method can be set 
for each ID. 

●	Checksum
Checksum has to be set only when Time is selected in the Frame End setting. 
Select the method of calculating checksum from Classic or Enhanced. 
* ID 3Ch-3Fh have to be calculated by “Classic”. 

●	DLC setting

This setting is displayed only when selecting “DLC” for “frame end”. Select the data length (0 to 8byte) 
for each frame and select the Checksum (Classic or Enhanced). 
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4.2 Start and Stop Measurement.

■	 Start Measuring

Click “ ” on the tool bar of data window (or click “Measurement” -> “Run measurement”). 

Received data can be displayed on the Data monitor display (normal view) at real time while monitoring.*1

Only specified ID frames can be displayed at Watch Data display. 

* If you specify the sampling interval (1ms to 10 seconds) for Interpolation of External input, 
  the analog waveform display screen will be displayed.

		  4.4 Watch Data Display

		  4.5 Analog measurement settings

■	 Stop Measuring 
Click “ ” on the tool bar of data window (or click “Measurement” -> “Stop measurement”). It is able to 
scroll data after the measurement in the Data Monitor display. Data will be saved into the specified folder 

set in the configuration settings. To open the previous files, click “ ” (or “File” -> “Data file”) and 

specify the file. To open the sequential order files, click “ ” or “ ”. 

	 * Please make sure that power saving mode of the PC does not cut 
	    USB connection. It will end the measurement of analyzer.

■	 Stop updating the display 
Click “      ” on the tool bar in the data window, or press “space” key to stop updating the display. Latest 
data can be displayed on the Data monitor (normal view) display.  
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4.3 Data monitor display
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Display Meaning
Time Displays the time (time stamp) when the frame is received.
deltaT Displays the difference of time stamps compared to ther previous time stamp.  

Ch Displays the channel received. (1: CH1, 2: CH2)

Break Displays the number of bit for Synch Break width for LIN. (Not displayed in CAN/CAN 
FD.)

Sync Dispays LIN Synch Field. (Not displayed in CAN/CAN FD.)

ID
CAN/CAN FD:Displays the received frame ID inHEX. 
LIN:Displays the Identifier excepting the upper two bit.
And displays the Identifier with parity in [  ] . Example: 11110101b -> 35 [F5]

Type

Displays the types of received frame. 
Data : Data frame of CAN/CAN FD  
Remote : Remote frame of CAN  
FData : CAN FD frame with BRS=0 and ESI=0  
FData! : CAN FD frame with BRS=0 and ESI=1  
FData* : CAN FD frame with BRS=1 and ESI=0  
FData*! : CAN FD frame with BRS=1 and ESI=1  
Error : Error frame of CAN/CAN FD  
Frame : Frame of LIN  
Illegal : Illegal frame of LIN  

DLC

CAN/CAN FD: Displays the contents of the data length code (number of data bytes) in 		
	    decimal.  
LIN : Displays the data length which is set by Configuration in decimal.
  (Not displayed when "Frame end" is set to "Time" in the configuration.) 

St

Displays whether the condition of the frame is normal or abnormal. 
G : Normal frame 
B : SynchBreak error of LIN. (Dominant is 10 bit) 
S : SynchField error of LIN.(other than 55h) 
P : Parity error of LIN. 
L : Data length error of LIN. (When “Frame End” setting is “DLC”.) 
R : When the data of the Response of LIN is less than 1 byte. 
C : Checksum error of LIN or CRC error of CAN/CAN FD. 
A : ACK error of CAN/CAN FD. 
E : Error frame of CAN/CAN FD. 
F : Form error of CAN/CAN FD. (When CRC or ACK delimiter is "0") 

Data Displays the contents of data field in HEX.

FC Displays the CAN/CAN FD CRC or LIN checksum value in hexadecimal. 

T1234
Displays the digital value of external input TRG IN/EXIN1/EXIN2/EXIN3/EXIN4. 
TRG IN : Pulled up with +5V 10KΩ, so when not connected, 1. 
EXIN1 ～ EXIN4 : 1 at 2.2V or above.  

TRG Displays the frames which satisfied the trigger conditions.

AI1 to 4 Displays the analog of external input EXIN1/EXIN2/EXIN3/EXIN4.(-16.0V ～ +16.0V)/
(0V ～ 32V).

Quality*1

Accuracy of the GPS 
invalid : The data received from the GPS module is invalid.

(The invalid range is Latitude, Longitude, Altitude, and Geoid. It does not include UTC) 
GPS : TThe data received from the GPS module is GPS positioning data. (Valid data) 
           The value on the right side means the number of satellites used for the positioning 
           (upto 9).
Blank : When it cannot receive from the GPS module. 
             Latitude, Longitude, Altitude, Geoid, and UTC will be blanks too.  

Latitude*1 Degrees of latitude by GPS (degree, minute, N/S)

Longitude*1 Degrees of longitude by GPS (degree, minute, E/W)

Altitude*1 Sea level altitude of GPS antenna (m)

Geoid*1 Geoid height of GPS

UTC*1 Coordinated Universal Time by GP (Hour:Minute:Second, Year/Month/Day) 
Year is displayed by two lower digits.  

X*1 X axis (g) from the acceleration sensor module (±8G)

Y*1 Y axis (g) from the acceleration sensor module (±8G)

Z*1 Z axis (g) from the acceleration sensor module (±8G)
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*1:These items are blank for LE-270AF. These items will be blank when you set OFF to “GPS/Acceleration set-
ting” at record control setting.
It might be displayed if selecting “GPS interpolation” function, even though nothing will be received from 
GPS module.

●	 Other Display
Display Meaning

(  ) Framing error (When the stop bit is Dominant.) e.g. (01)
LOSTDATA Displayed in “Ch” field. It means there is lost of data while transmitting into PC. 
CAPTURESTOP Displayed in “Ch” field. It means capturing function is not running.
OVERRUN Displayed in “Ch” field. It means the buffer in the analyzer becomes full while 

measuring.

●	 Data detail display section

Displays only the data field of the selected CAN/CAN FD or LIN frame in hexadecimal. 

●	 Data position display section
It displays the number of data loss (Analyzer cannot save data in the SD card or HDD of PC because of 
the baud rate and large amount of data) while measuring. “LOSTDATA” will be displayed in the monitor 
display.
After the measurement, it will display the position of top of data displayed in the monitor display. 
If the Capture Control Trigger stops capturing, “Capture stopping ...” will be displayed.  

*	 The direction of the acceleration censor is as in the picture below. The upper side gives plus value. 
For example, when the side of the Dsub25 port is the upper side (in other words, when RUN/STOP button 
side is the bottom side), Y value will be plus and the X and Z values will be 0.
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4.4 Watch Data Display
At the Watch Data display, only specific ID frames can be displayed. Only the latest data will be displayed and 
it is updated every one second.

■	 Setting of Watch Data Display
Click “ ” on the tool bar of the data window (or “tool” -> “Watch Data settings”). Set the target channels 
and ID.

● Channel
	 Select the measurement port from “Ch-1” or “Ch-2”.
● Frame type
	 Select the frame type from “Standard” (CAN standard format, LIN) or “Extended” (CAN expansion 

format).
● ID
	 Set the frame ID in HEX. The one set in here will be displayed in the Watch Data display. 
		  CAN standard format: 0-7FFh
 		  CAN expansion format: 0-1FFFFFFFh
 		  LIN: 0-3Fh
● Include all frames

Uncheck : It displays normal CAN data frames that matched with ID setting (No.1 to F), or frames 
with LIN response data.

Check : It displays all frames that matches with ID setting including remotes and errors.
(It cannot find the error status in the Watch Data Display.) 

	 ● Auto
Uncheck : It displays frames that matched with the ID setting (No.0 to F) on the Watch Data Display.

Column number (No.) of Watch Data Display turns to be 0 to F.
Check : It displays frames in the order of monitoring on the Watch Data Display. (Setting on No.0 to 

F will be ignored).
Column number (No.) of Watch Data Display turns to be the monitor ordering number (0 to 
99).

	 Note: It clears by pushing “OK” after changing it.

*Cannot edit or print the watch data display.
*Watch Data display will be erased when starting the measurement.
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1).	 Maximum display voltage
	 Maximum display voltage can be selected from 1V, 2V, 5V, 10V, 16V or 32V. 
2).	 Display/Undisplay the graph of AI1 - 4 
	 The graph of checked AI is displayed. 
3).	 Cursor 
	 The cursor (red dotted line) on a graph can be moved to right and left by the mouse or a Shift + arrow key. 
4).	 The voltage value of the cursor position 

The voltage value of the cursor position on the graph (AI1 - 4) would be displayed on the upper right 
([Cursor]) of a graph. 

5).	 Display the present voltage value 
	 During Analog mode,  the latest value would be displayed on the right ([Now]) of a graph and be updated 

every 1 second. 
*	 When displaying the stored data, a scroll bar is appeared and it enables scrolling back to the past data. 

4.5 Analog measurement settings 
Display the analog waveform at the specified sampling cycle. 

	 <Analog Waveform Display>
	 Analog waveform will be displayed only monitoring at Analog mode or displayed data measured by 
	 Analog mode. 

■	 Analog mode setting 
On “Interpolation of External input” of “Measurement setting”, set “None” (only for when capturing com-
munication frame) or 1ms to 10s (periodic recording).

4)

5)

3)

2)1)
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Chapter 5 Simulation Function 

The simulation function performs a transmission/reception test according to the protocol as a communication 
partner of the device when the other device is not prepared at the initial stage of development. For CAN/
CAN FD, the data registered in the simulation data tables (0 to F) can be sent with one touch on the operation 
panel. 
For LIN, there are “Master” and “Slave” mode. When selecting the “Master” mode, send the pre-registered 
headers (max. 16) in the orders from the control panel by one click or automatically. When selecting the “Slave” 
mode, the response data is send automatically after receiving the same header ID from the master, matched 
with the one in the simulation data table (0 to F).
* Only Ch-1 is available for simulation. 
* For CAN/CAN FD, ACK will be sent automatically for every frame. (The simulation port acts as a node.)
* For more details, refer to the online help (“Help” -> “Contents”) on the PC software “LE-LINK27F”.

5.1 Preparation of Simulation
Click “Function” -> “MANUAL” -> “Interface”, and select “CAN” or “LIN” for “Ch-1”. For LIN, select 

“Master” or “Slave” when selecting the MANUAL simulation mode.

■	 Mode 
Select “Master” or “Slave” for LIN simulation.  

■	 Sync-ID space (for Master) 

When selecting the Master mode, set the interval between the synch field and ID field (0 to 99bit).  

■	 Response space (for Master) 

When selecting the Master mode, set the interval between the header and response (0 to 99bit).  

■	 Byte space 

Set the interval between the response and data (0 to 99bit).  

■	 Interval (for Maser) 
Set the interval (3 to 99999msec) of transmitting frames using the Schedule function. Set longer value than 

the frame length.  
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■	 Repeat number (for Master) 
Set the number of times (0 to 99999) that the frame is sent repeatedly using the Schedule function (The 
header set in the request ID table). If “0” is set, the transmission will continue endlessly. (The Schedule 
function has to be “ON”).  

■	 Schedule (for Master) 

ON : Transmit the LIN header including the valid ID set in the request ID table automatically in the 
order of table number.

OFF : Transmit the LIN header including the valid ID set in the request ID table when corresponding 
key (0 to F) of request ID table is pressed. This function is not available for logger mode.

  

5.2 Simulation Table Setting
Click “Measurement”-> “Measurement setting” on the menu bar, and set the data to be sent to each table 0 to F 
of the simulation data table.
■	 Simulation data table

A simple list of the settings of each table 0 to F is displayed. 
■	 Table 0 ~ F

Set the data to be sent to 0 to F (maximum 16) in each table. The data format to be set differs depending on 
the protocol (CAN or LIN) set for the Ch-1 interface. 

5.3  CAN Table Setting
Set the simulation data table (0 to F) used for CAN simulation.

■	 Type
Select the frame type.

Type Description
DATA CAN standard format data frames
EX-DATA CAN Extended format data frames
REMOTE CAN standard format remote frames
EX-REMOTE CAN Extended format remote frames
FD DATA CAN FD standard format data frames
FD EX-DATA CAN FD Extended format data frames
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■	 ID
Enter the ID by HEX with 11 bits (when it is standard format) or 29 bits (when it is extended format).
Standard format : 000 to 7FFh 
Extended format : 00000000h to 1FFFFFFFh 

■	 Data (When data (standard/extended) or FD data (standard/extended) is selected)
Displayed when Data (Standard/Extended) or FD Data (Standard/Extended) is selected for Frame Type.
When Data (Standard/Extended) is selected, enter the maximum 8 bytes of data in the data field in hexa-
decimal.
When FD Data (Standard/Extended) is selected, the set first 8 bytes of data are displayed in hexadecimal, 
The setting is entered by editing the data.

■	 Edit data table (When FD data (standard/extended) is selected)
This is displayed when FD data (standard/extended) is selected for the frame type.
Click the “Edit Data Table” button to display the data table edit screen, Enter the maximum 64 bytes of 
data in the data field in hexadecimal.

Toolbar Meaning
Switches between hexadecimal and ASCII display.

Switches between hexadecimal and ASCII input.

Cuts the selected text.

Copies the selected characters.

Cut or paste the copied text.
Input data from "Begin data" to "End data" for the number of characters in 
"Data size".
[Begin data] > [End data]: Input the number of characters from [Begin data] + 1.
[Begin data] < [End data]: Input the number of characters from [Begin data] 
by [-1].
Delete all data in the table.

■	  BRS (When FD data (standard/extended) is selected)
To change the communication speed of the CAN FD data field, check the box.

■	 DLC (When Remote (standard/extended) is selected)
Displayed when Remote (Standard/Extended) is selected in Frame Type.
Enter the number of bytes of data to be requested in decimal.
The value can be set from 0 to 8 bytes.

■	 Repeat
Enter how much it repeats the transmission of frame by decimal. 
The range should be from 0 to 99999. 
It continues transmitting repeatedly when you set 0.

■	  Interval
Enter the interval of the time of repeat transmission by decimal. 
The range should be from 0 to 99999msec.

■	 Sweep
It appears when you select the frame type of “data frame” at “Type”. 
Select presence or absence of data sweep (continuous change).
ON :  With sweep 
OFF :  Without sweep 

 5.4 Sweep setting		  
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5.4 Sweep setting
When Sweep is ON, set the following.

◆ Endian
Select the storage order (LITTLE, BIG) of the data to be swept.
For example, if 0123h is set, each byte order will be as follows.

BIG: 01h 23h LITTLE: 23h 01h

◆ Size
Select the size of the data to be swept from 8 bits and 16 bits.
Overflowed bits are ignored. For example, when 8-bit is selected and the data to be swept is 256(100h), 
it is set to 00h.

◆ Position
Sets the position of the data field where you want to insert the data to be swept.
For example, if the size is 16bit and the position is 2, the gray part will change (sweep).

0 1 2 3 4 5 6 7
Data Field

The data set in the data item (up to 8 bytes) is sent except for the set position.

◆ Initial
Set the initial value of the data to be swept in decimal (-32768 to 65535).

◆ Time １～ 3
Set the time to change to the target value (values 1 to 3) in decimal (0 to 999999msec).
For example, it changes to the target value (value 1) during the time 1.

◆ Value 1 ～ 3
Set the target value in decimal (-32768 to 65535).
The relationship between the target value (values 1 to 3) and time (time 1 to 3) is as follows.

◆ Loop
When checked, the sweep operation is repeated.
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5.5 LIN request ID table setting (for Master)

Set the header in the request ID table for 
LIN Master simulation.

■	 ID
Set the header ID for the PID filed in 
HEX. Mark on the box (0 to F) to en-
able the setting. Set the response in the 
simulation data table. 

■	 Break error
Set the error for the break field (0 to 99). 
13bit will be set automatically if input-
ting nothing. 
(Attention: The break signal should be 
the max 6ms. Set the appreciable bit.) 

5.6 LIN table (Response data) setting

Set the transmission data in the response 
filed (simulation data table 0 to F) for LIN 
Master/Slave simulation.

■	 Enable
If checked, the response is automati-
cally sent when the ID in the received 
header matches the ID you set.
If unchecked, the response is not sent 
even if the IDs match.

■	  ID
Set the ID to be responded (excluding 
parity) in hexadecimal (00h to 3Fh).

		  

■	 Synch error
Set the error for synch field in HEX. “55h” will be set automatically if inputting nothing. 

■	 Parity error
Mark on the box to send the parity error in that frame. Inverted value of the parity will be sent as the error. 

＜ Caution ＞

When it is in slave simulation, data of the smaller table number will be sent if the ID of the table 0 to 
F is redundantly set. 

■	 Data
Input the data by HEX up to 8 bytes. 

■	 Checksum
Set the checksum by HEX. 
When nothing is input, it transmits calculating automatically by the checksum method set at Ch-1 configu-
ration. 
By pushing [ Calculate ] , you can set the value calculated by the checksum method set at Ch-1 configura-
tion.

■	 Sweep
Select ON/OFF of sweeping data (changing continuously). 

 5.4 Sweep setting
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* The operation panel does not open when measurement is stopped or in the online mode .
* Please use the simulation by the trigger because this cannot be used in the communication logger mode.  

2. Click the button of the table number to be transmitted.
3.  If you want to stop the data transmission for which the repeat is set during transmission, click the “Stop 

repeated sending” toggle button, and then click the table number button for which you want to cancel 
transmission in succession. After that, click the “Stop repeated sending” toggle button to return the but-
ton to the original state.

■	 Stop the Simulation
1. Close the operation panel.
2. Execute “Stop measurement”. 

■	 Simulation by a Trigger
In the simulation preparation, set the trigger setting to “Send data” for triggers 0 to 7 in the “Trigger” 
setting. When measurement is started and the trigger conditions are met, the data transmission control can 
be performed automatically. As no operation is required from the operation panel, it can also be used in 
communication logger mode.

5.7 CAN Simulation
■	 Start the Simulation

1. Click “Run measurement” to open the operation panel.

＜ Caution ＞

When there is no ACK response from other nodes on the CAN bus or when there is a frame 

transmission, the data cannot always be transmitted exactly as the button is clicked.

In addition, the data may not be sent due to factors such as overlapping time of multiple table 

settings.

When there is no ACK response, the same data will continue to be sent regardless of the repeat 

setting, and in this state the transmission cannot be stopped unless the measurement is stopped.
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5.8 LIN Simulation
■	 Starting the LIN Master Simulation

1. Click “Run measurement” to open the operation panel.

* Request ID table buttons 0 to F and setting details (ID) are displayed.
* The operation panel does not open while measurement is stopped or in online mode.
* [WekeUp(80h)] can transmit the dominant of 80h while [WekeUp] can transmit the dominant of 0.25msec 

or more. 
Dominant time will be the time of the sum of 1 bit time of the configured communication speed when 
it is more than 0.25msec.

* “Stop repeated sending” is not available. 
* When setting “ON” for “Schedule”, the headers are automatically sent in the order of Request ID tables 

after starting the measurement. 

2. Click the button for the table number (Request ID table number (No.)) you wish to send.

When the monitored header in the LIN communication is matched with the ID set in the table 0 to F, the 
response data is automatically sent.

■	 Starting the LIN Slave Simulation
1. Start measuring.
2. When monitored transmission request header from the Master is matched with the ID set in the table 0 to F, 

the response data is automatically sent.
* The transmission request header from the Master is necessary to send the data.
* Sending only [WekeUp(80h)] or [WekeUp] is possible for Protocol Analyzer mod. 

Sending data by pressing the table number and “Stop Repeat transmission” are not available. 

■	 Stop the simulation
1. Close the control panel.
2. Execute “stop measurement”.

＜ Caution ＞

In data logger mode, operations using the operation panel are not possible.
You cannot stop the transmission without stop the measurement. 
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Chapter 6 Use of wireless LAN (Wi-Fi)

To use Wi-Fi function of LE-270AF/ LE-270GF, you need to power the analyzer after inserting SD card in 
which Wi-Fi configuration file (WLANCFG.WL) is written.

< How to make a Wi-Fi setting file >
1. Click LE Wireless LAN configuration from the start menu.
2. Select Station or Access point and set the items to be required.

■Station Mode 
The analyzer connects with Wi-Fi via access point.

SSID : Set the SSID of the access 
point to be connected.

Password : Set the password of the 
access point.

IP address : Set the IP address of the 
analyzer.

Subnet mask : Set the subnet mask of the 
analyzer.

Gateway : Set the IP address of the 
gateway when you use it.

Port number : Set the data port of the 
analyzer.

■Access Point Mode 
The analyzer turns to be an access point and connects with Wi-Fi.

SSID : Set the SSID of the 
analyzer.

Password : Set the password of the 
analyzer.

IP address : The IP address is fixed to 
192.168.4.1 

Channel : et the channel to be used 
for Wi-Fi connection.

Port number : Set the data port to be 
connected.

* DHCP server function is set to valid in the access point mode. 
  You can use "Automatically obtain IP address" in the network setting of PC.

3. Press “Save” to save the setting file for Wi-Fi (WLANCFG.WL) to a SD card.
4. Insert the SD card in which Wi-Fi setting file is written into the analyzer.
5. Power the analyzer.
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Chapter 7 Useful Functions

7.1 Trigger Function
Trigger function is to start a specific action upon occurrence of a specific event as the trigger. A perplexing flow 
of data, which is not easy to be analyzed in the normal monitor operation, is analyzed on the basis of occur-
rence of the specific event.

Click “ ” on the tool bar of the data window (or “Measurement” -> “Measurement setting”). And then open 

the trigger setting.

Up to eight triggers can be set. 
Trigger factor and action can be 
set for each trigger independently. 
Each trigger can be set either to be 
enable or disable.

Trigger condition Description
Error CAN/CAN FD/LIN error detection

CAN Data Detection of specific CAN/CAN FD data frames
CAN Remote Detection of specific CAN remote frames

LIN Data Detection of specific LIN frames
Timer, Counter Timer or counter corresponds with the set value
External Input The logic of external inputs (EXIN1 to 4) matches the set value

TRG IN TRG IN edge matches the set value

Trigger action Description
Stop measurement Stop measurement

Timer control Start, stop, and restart of timer
Counter control Clear and count up of counter
Trigger control Performs actions to enable or disable triggers

Send data Transmission control of CAN data table
Outoput TRGOUT2 It outputs about 1ms Low pulse to TRG OT2.

LED output ON/OFF of the specified LED.
Capture Control Start/Stop capturing. *1



-31-

7.2 Text Conversion
	 Measured data can be converted into text file or CSV file.

	 Click “ ” on the tool bar of the data window (or “Tool” -> “Text Conversion”).

●	[Folder]
	 Select the file to convert into text.

	
●	[Conversion Options]
	 Select the type of conversion.

		  	 ●	[Conversion Channel]
					     Select from “CH1&CH2”, “CH1” or “CH2”.
			   ●	[LIN RAW data]
					     Select only for LIN communication.

					     OFF :	Do not include the parity bit on the ID. Framing error will be converted as “##”. Others will be 
displayed in HEX.

					     ON  :   Include the parity bit on the ID. Framing error and all data will be displayed in HEX.
	    ●	[Output CSV file]: 
			   Output data in CSV format.
	    ●[Timestamp is output by difference]: 
			   Output elapsed time stamp from the previous frame. 
			   (If selecting CSV format, elapsed time stamp is always output.)
	    ●[KML]: 

        It outputs the GPS data (latitude, longitude) of LE-270GF as KML format file. 
   	    ●[Data file list] 
		    Select the files to convert into text format. Click once to select, and click again to release the selection.    
　　　   It is able to select more than one files.
         ●[ Refresh ]
		    Update the list of data files.

   ●[Select All]
	   Select all files in the data file list. 
   ●[Clear]
	   Clear all files selected in the list of data files.

■	 Execute Conversion
	 Select the monitor data files and click “				        ”. 
	 Converted file will be saved in the selected folder.
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Chapter 8 Data Logger Mode

According to the configuration settings in the SD card, analyzer can record data for long hours without a PC.

8.1 Preparation of Data Logger Mode
	 Click “       ” on the tool bar of the data window (or click “Measurement” -> “Measurement setting”) to open 　   	
	 the setting display and set the items for data logger mode. 

	

1).	 Select the interface.   3.2 Configuration of Analysis Software
2).	 Select the configurations according to the target devices.  4.1 Communication Condition
3).	 Select the trigger conditions if necessary.  7.1 Trigger Function
4). Select how to save the data.

		 ● Saving Mode
“Restart”     : Delete the existing files first, and then start measuring from the file name of “#0000000.DT”. 
	            Record data as a ring mode. (Delete the oldest file when the number of files reaches to the “Max 
	           Files”.) 
“Max-stop” : Delete the existing files first, and then start measuring. Stop measuring when the number of        
　                    files  reaches to the “Max Files”. 
“Append”   : Existing files will not be deleted. Record data as a ring mode. The file name will be the   	

 sequence number after the existing files.

* For 2GB SD card, the max file number for saving data will be 512.

		  ● Max Files
			   Set the max number of files to save. 

Select “Append” for normal operation. Especially when you use Auto RUN/STOP function, or in the 
condition of [Run] key can be pressed accidentally, select “Append” mode.
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Reference for how long it can record (When max. file number: 450, filesize: 4MByte (1.8GB in total))
In the case that it transmit a frame in the interval of 1m second

            

Click “ ”to save the configuration in the SD card. The file name will be “LE270F#.SU”. Before starting 

the measurement as a data logger mode, read the configuration file (“LE270F#.SU”) to the analyzer.

<Attention>

	 The analyzer does not log the data if you use a SD card which has more 	

　      capacity than the one supported by the analyzer.

Frame number per 1 file (4M) Record time per 1 file (4M) Record time for 450 files
About 131072 frames About 2 minutes and 10 second About 16 hours

		  ● File Size
			   Select the file size to save.
			   “Max Files” x “File Size” will be the capacity of logging data. Consider the actual memory capacity of 
			   the SD card.						    

(An example of SD card capacity) 2GB SD card: 1.8GB
			      8GB SD card: 7.4GB
・ Following is the table of consuming memory by one frame.

Per 1 frame
(Up to 8 bytes of data)

Per 1 frame
(Up to 36 bytes of data)

Per 1 frame
(Up to 64 bytes of data)

Without GPS/ 
acceleration 
monitoring

With GPS/ 
acceleration 
monitoring

Without GPS/ 
acceleration 
monitoring

With GPS/ 
acceleration 
monitoring

Without GPS/ 
acceleration 
monitoring

With GPS/ 
acceleration 
monitoring

LE-270AF About 32 
Bytes - About 64 

Bytes - About 96 
Bytes -

LE-270GF About 32 
Bytes

About 64 
Bytes

About 64 
Bytes

About 96 
Bytes

About 96 
Bytes

About 128 
Bytes

			   Numbers of frames saved in the 1M data of one file is following.
Numbers of frames saved in the 1M data of one file

Per 1 frame
(Up to 8 bytes of data)
(CAN/CAN FD/LIN)

Per 1 frame
(Up to 36 bytes of data)

(CAN FD)

Per 1 frame
(Up to 64 bytes of data)

(CAN FD)
Without GPS/ 
acceleration 
monitoring

With GPS/ 
acceleration 
monitoring

Without GPS/ 
acceleration 
monitoring

With GPS/ 
acceleration 
monitoring

Without GPS/ 
acceleration 
monitoring

With GPS/ 
acceleration 
monitoring

LE-270AF About 32.768 
frame - About 16.384 

frame - About 10.922 
frame -

LE-270GF About 32.768 
frame

About 16.384 
frame

About 16.384 
frame

About 10.922 
frame

About 10.922 
frame

About 8.192 
frame
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8.2 Start and End of the Measurement

■ Start Measuring 
	 1).		 Connect the analyzer to the target device.

2).	 Insert the SD card, which saves the configuration (LE270F#.SU) of the analyzer.

3).	  Supply the power to the analyzer using the AC adapter or power cable (SIH-2PG). LED of   　　

POWER/ ERROR will be lighting in orange.
4).	 If Auto Run function is set, LED of RUN/ACT will be lighting in green. If setting the date of 　　

Auto Run, the power will be supplied at 1 minute before starting the measurement, and LED of 　 

RUN/ACT will be lighting. 

*	 The configuration will be sent to the analyzer when switching on the power of 

	 analyzer. Even you change the SD card after switching on the power, the 

	 measurement will start according to the configuration of SD card which was set when 

	 switching on the power of analyzer.

*	 The analyzer will not record data if there is not the SD card with configuration data.

	 If you do not use the Auto Run function, you need to press the RUN/STOP button.

■ End Measuring
Click the RUN/STOP button if LED of RUN/ACT is lighting in green.

*	 Do not remove the SD card or power supply while LED of RUN/ACT is lighting in red.

*	 Make sure to check the light of LED of RUN/ACT after clicking the RUN/STOP button.
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8.3 Receive the logger files by Wi-Fi connection.
When using the logger mode, the application “lefiledownlod.exe” can transfer the log files in the SD card to 
the PC via Wi-Fi. To use this application, copy the Wi-Fi setting file “WLAN CFG.WL” made by “Wireless 
LAN configuration file” to the SD card (which is used for the logger mode) besides the setting file for the log-
ger mode.

 Chapter 6 Use of wireless LAN (Wi-Fi)
*Start “LE file downloader” by clicking this application from the start menu.

		  

1) Input the IP address and the port number 
set in the analyzer.

2) Click “Connect” and the list of log files 
appears. 
Click “Update list” and the latest ones 
are displayed on the list window. 

3) Select the target data. To select all data, 
clock “Select all”.
(Note): Files in the middle of logging 

cannot be transferred correctly 
(an e r ro r wi l l occur when 
displayed). 
Please note that the file with the 
largest file name number may 
be in the middle of logging.

4) Click “Download” to send the files to the selected folder.
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8.4 Auto Run/Stop Function
By setting the specified start and stop time/date, the analyzer can automatically start and stop the 
measurement. Click “        ” on the tool bar of the data window (or click “Measurement” -> “Measurement 
setting”) to open the setting display and set the items at “Auto run/stop”.

8.5 Use of Log files
Log files will be named as “xxxxxxxx.DT”(“x” will be the sequential number). 
These files can be analyzed by “LE-LINK27F”.

1).	 Insert the SD card to the SD card drive of the PC.

2).	 Click “ ” button, (or “File” -> “Open files”) and select the SD card drive. If you open more than one 

	 files, it will be displayed as sequential data.

* Stop time
Specify the ending time of the measurement. The power will be turned off after the measurement 
automatically.

* Power On Run
Start measuring when powering on the analyzer. Select from “Safely start ” or “Quick start”. For normal 
operation, select “Safely start”. Safely start will start measuring approximately 40 seconds after powering 
on the analyzer for charging the capacitor for back-up data.

Time stamp information is based on the time of RTC (Real Time Clock) embedded in the analyzer. 
RTC is set when the product is released from the factory. And also when connecting it to the PC 
by protocol analyzer mode, RTC is set according to the time of the PC.

* Do not remove the SD card while opening more than one files, 

* Mode
	 [Monthly] : 
		  Start measuring at the specified time 
		  every month. 
	 [Daily] : 
		  Start measuring at the specified time 
		  every day. 

[Hourly] : 
	 Start measuring at the specified time 
	 every hour. 

* Run time
Specify the starting time of the 
measurement. The power will be 
supplied at 1 minute before starting the 
measurement.
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Chapter 9 Update Firmware

You can update to the latest firmware by the PC, which installed the USB driver. The latest firmware will be 
available from the LINEEYE website. Connect the analyzer to the PC and execute “LE8FIRM.EXE” and 
follow the instruction. 

■ Check Firmware Version
Click “Tool” -> “Check firmware”of the “LE-LINK27F”. 
 

If you need to update it to the latest firmware, execute “LE8FIRM.EXE” which is stored in the attached 
CD-ROM. 

■ Update Firmware
Connect the analyzer to the PC.

	 1). Double-click on “LE8FIRM.EXE”.
	 2). Select the serial number of the analyzer
	 3). Click [Next]. 

	 4). Select the downloaded firmware file 
	

	 5). 	A note for updating firmware will be 
		  displayed. Read it carefully and click 
		  [Start]. 

		  The firmware loader will start operating. 
		  The LED of POWER/ERROR will be 
		  lighted Off and LED of RUN/ACT will be 
		  lighted On while the firmware loader is 
		  operating.

	 6). 	After a short time the firmware is updated  
　        and a message “Complete” appears.
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Chapter 10 Specifications

10.1 Interface (CAN/LIN/External Input)
Dsub 25pin connector is for the port of CAN, LIN and external input signal.

Pin NO Signal name Function
1 BATT LIN battery power input and analyzer power input
4 GND Signal Ground
7 GND Signal Ground
9 EXIN1 External Input 1

10 EXIN2 External Input 2
11 EXIN3 External Input 3
12 EXIN4 External Input 4
14 TRG_IN Trigger Input
15 CAN_1H CAN Signal (channel 1)16 CAN_1L
17 TRG_OT2 Trigger Output 2
18 TRG_OT1 Trigger Output 1
19 CAN2_H CAN Signal (channel 2)21 CAN2_L
22 GND Signal Ground
23 LIN1 LIN Signal (channel 1)
24 LIN2 LIN Signal (channel 2)

	 * No. 4, 7 and 22 are connected internally. 
   Connect the ground of same electric potential to those pins. 

10.2 External Input/Output Terminal
<External trigger input/output terminal>

Pin NO Signal name Function/Specification

14 TRG_IN
External trigger input	 TTL level input +5V, 10kΩ pull-up 
Range: -0.5V - 6.0V

17 TRG_OT2 External trigger output 2	 Open drain output   +5V, 10kΩ pull-up 

18 TRG_OT1 External trigger output 1	 Open drain output   +5V, 10kΩ pull-up 

Pin NO Signal name Function/Specification

9 EXIN1 Input 1, 160k pull-down, Range: ±25V

10 EXIN2 Input 2, 160k pull-down, Range: ±25V

11 EXIN3 Input 3, 160k pull-down, Range: ±25V

12 EXIN4 Input 4, 160k pull-down, Range: ±25V

	 * EXIN1-EXIN4 are non-isolated (use same ground). 

	 * Range of analog measurement is ±16V. Max. Input is +32V.

<External input signal> 

1 13

14 25
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10.3 Specifications
Model LE-270AF　 LE-270GF

Interface CAN/CAN FD: Comfort to ISO11898-2:2016 standard. MCP2544FD 
LIN: Comfort to ISO9141 standard. TJA1021 

Isolation －
1kV galvanic isolation between USB connector / SD 
card slot and measurement process section.

Connector DSUB 25 pin male connector #4-40UNC

Number of Channels 2 channels (2 ports of CAN/CAN FD or LIN, or a combination of 1 port each of CAN/CAN FD and 
LIN)

Protocol CAN, CAN FD (ISO/ non-ISO), Device net, LIN (Rev1.1, 1.2, 1.3, 2.0, 2.1) 

Baud Rate CAN/CAN FD: 125Kbps to 1Mbps,  CAN FD( data phase ): 1Mbps to 5Mbps, 
LIN: 400bps to 26Kbp (arbitrary speed)

CAN Monitor Standard/ Expansion format. Sample points can be set arbitrarily

LIN Monitor Frames can be separated by specifying data length for each ID or by time (standard maximum frame 
time).  

Error Check CAN/CAN FD CRC, ACK, Error frame, Form 
LIN Break, Sync, Parity, Checksum, Framing, Response

Memory PC: Max. 32G byte in the HDD. Logger mode : Capacity of SD card. (Able to specify 
128K/1M/2M/4M/8M/16M/32M and numbers of files) 

Mode Remote mode (with PC); Data Logger mode (PC-less)
Measurement test mode Online mode, Manual transmission mode
Measurement start/stop Control from PC, Start/Stop switch, Auto-Power run, Specify date and time.
Time Stamp  9 digits:“Hr:Min:Sec:x1ms”,“100μs”,“10μs”,“1μs” (selectable) 

Filter Record specific ID (Bit-mask available) for each channel (acceptance filter). For CAN, there are also 
pass filter (8sets), cut filter (8sets) which can be used with acceptance filter.

Display on PC Real-time display, Watch data display (display specified data of each ID), Analog waveform display.

Trigger

Condition
Error (Break, Sync, Parity, Framing, CRC/Checksum) *2 , specific CAN data frame (channel, ID, 
data, off-set, bit-mask), specific CAN remote frame (channel, ID), specific LIN frame(channel, ID, 
data, bit-mask), timer/counter coincidence, external signal logic, external signal input edge.

Action
Stop measurement (offset can be set), validates/invalidates trigger condition, control timer/counter, 
turn on/off the light of user-defined LED, output external signals, transmit CAN data (if using 
Manual mode), start/stop capturing.

Retrieval function on PC

Trigger matched data, Error (ACK, form, error frame, break, sync, parity, Checksum, Framing, 
CRC/ Checksum), specific CAN data frame (channel, ID, data, off-set, bitmask), specific CAN 
remote frame (channel, ID), specific LIN frame (channel, ID, data, bitmask), specific time stamp, 
external signal logic

Conversion Convert data into Text, CSV or KML format and save. 

External Signal Input

4 channels of Digital/Analog.
Recording: At the time of receiving signals, or specified sampling cycle (1ms - 10min, 13steps). 
Analog input -16V to +16V/0V to32V, Resolution: 10bit, Accuracy: ±0.5%FS, Max. 50Ksps.
Digital input: threshold: 1=2.2V or more

Acceleration data －
Register and display the acceleration data of X/Y/
Z axis. The sensor KX022-1020-FR or equivalent is 
built-in.

GPS positioning data －
Register and display the latitude, longitude, above sea 
level. SMA (femal) connector for active GPS antenna 
is built-in.

LED 5 two-color LED: Power/Error, Measuring/Recording, CH1/CH2, User-defined U1/U2, WiFi/GPS *1

Switch	 One: RUN / STOP
External Trigger Signal 1 Input, 2 Output (equipped in the measurement connector)
SD Card 2 – 32Gbyte SD/SDHC *3

USB2.0 Port Mini-B connector. High speed supported.

Wi-Fi Connection *4
IEEE 802.11 b/g/n 
Frequency range : 2400MHz-2483.5MHz 
TX POWER: 802.11b: +20dBm   802.11g: +17dBm   802.11n: +14dBm

Power USB bus power, DC-IN, or 1 pin of battery terminal of measurement connectorExternal DC power 
(DC9-34V), AC adapter (6A-181WP09). 

Power consumption About 1.4W (2.8W when using Wi-Fi) *5 About 2W (3.4W when using Wi-Fi)  *5

Run time during power 
failure Approx. 0.5sec

Ambient Temperature, 
Humidity In operation: -20-+55°C In storage: -20-+60°C, 20 - 85%RH (No condensation) 

Dimension, mass 86(W)×130(D)×30(H) mm approx. 240g
Environment of PC OS:Windows®  10/11　PC: PC/AT compatible 

Accessories
PC software, Mini-USB cable, CAN/LIN Dsub cable, Power plug cable, 8G byte SDHC card,
Instruction Manual,Warranty

*1: LE-270AF does not have GPS function.
*2: “Break, Sync, Parity, Framing” are available only for LIN.
*3: Only SD/SDHC cards sold or attached by LINEEYE are supported.
*4: Wi-Fi function is available only in Japan, USA, Canada, and EU nations where the product is needed to be compliant with RE

 directive (2014/53/EU). The Wi-Fi function of this product is set to invalid depending on the country where it is shipped. 
Please contact LINEEYE for the detail.

*5: When supplying DC12V from DC-IN.
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10.4 Options

* Wide input AC adapter : 6A-181WP09 : Power supply for Data Logger mode, DC9V center (+)
* OBD2-DSUB25 cable : OBD2-DB25R2-1 : CAN monitor cable for OBD2 connector (1m)
* Clip cable : LE-9LP2 : CAN/LIN clip monitor cable.
* GPS active antenna : EB-SL-AA170 : Supports Beidou, GPS, and GLONASS.Waterproof and   

dustproof (IP65)Available only with LE-270GF
* DIN rail mounting plate : LE-DIN13  : To connect analyzer on the 35mm DIN rail.

	 OBD2-DB25R2-1

	 LE-9LP2

	 EB-SL-AA170

(female) (male)

(female)

SMA connector (male) GPSantenna
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Chapter 11 Warranty and Repair

	 Warranty
*	 This product package contains a warranty.
*	 Read the warranty and keep it in the safe place.

	 Repair
*	 LINEEYE will repair the product according to the warranty.
*	 After the warranty period, LINEEYE will repair the product for you to use the functions properly at your 

own expense. If your product needs to be repaired, please tell us the model name, serial number, purchased 
date, and the details of problems.

---User Registration---
Please register your products from our website.  We will provide you the 

update information and so on.
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